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Chapter 519

Paired T-Tests for
Equivalence
Introduction
This procedure allows you to study the power and sample size of tests of equivalence of means of two correlated
(paired) variables. Schuirmann’s (1987) two one-sided tests (TOST) approach is used to test equivalence. The
paired t-test is commonly used in this situation.
Paired data may occur because two measurements are made on the same subject or because measurements are made
on two subjects that have been matched according to other, often demographic, variables. Hypothesis tests on paired
data can be analyzed by considering the differences between the paired items. The distribution of these differences is
usually symmetric. In fact, the distribution must be symmetric if the individual distributions of the two items are
identical. Hence, the paired t-test is appropriate for paired data even when the distributions of the individual items
are not normal.
The definition of equivalence has been refined in recent years using the concepts of prescribability and
switchability. Prescribability refers to ability of a physician to prescribe either of two drugs at the beginning of
the treatment. However, once prescribed, no other drug can be substituted for it. Switchability refers to the ability
of a patient to switch from one drug to another during treatment without adverse effects. Prescribability is
associated with equivalence of location and variability. Switchability is associated with the concept of individual
equivalence. This procedure analyzes average equivalence. Thus, it partially analyzes prescribability. It does not
address equivalence of variability or switchability.

Outline of an Equivalence Test
PASS follows the two one-sided tests approach described by Schuirmann (1987) and Phillips (1990). It will be
convenient to adopt the following specialize notation for the discussion of these tests.
Parameter
𝐸𝐸𝐿𝐿 , 𝐸𝐸𝑈𝑈

PASS Input/Output Interpretation
EL, EU
Lower and Upper Equivalence Limits. If the average paired difference is
between these two limits, the treatment is said to be equivalent to the
reference.

𝛿𝛿

𝛿𝛿

𝛿𝛿1

𝛿𝛿1

Population mean of paired differences. This is the mean of paired
differences, 𝑋𝑋1 − 𝑋𝑋2 , in the population. This parameter will be estimated
by the study.
Actual paired difference at which power is calculated. This is the value
of the mean paired difference at which power is calculated.

519-1
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Paired T-Tests for Equivalence

With 𝐸𝐸𝐿𝐿 < 0 and 𝐸𝐸𝑈𝑈 > 0, the null hypothesis of non-equivalence is
The alternative hypothesis of equivalence is

𝐻𝐻0 : 𝛿𝛿 ≤ 𝐸𝐸𝐿𝐿 or 𝛿𝛿 ≥ 𝐸𝐸𝑈𝑈 .
𝐻𝐻1 : 𝐸𝐸𝐿𝐿 < 𝛿𝛿 < 𝐸𝐸𝑈𝑈 .

Paired T-Test Statistic
A paired t-test is used to analyze the data when the standard deviation of paired differences is unknown and
estimated by the data. The test assumes that the data are a simple random sample from a population of normallydistributed values that have the same variance. This assumption implies that the differences are continuous and
normal. The calculation of the two, one-sided t-tests proceeds as follow
𝑡𝑡𝐿𝐿 =

𝑡𝑡𝑈𝑈 =

𝑑𝑑̅ − 𝐸𝐸𝐿𝐿

𝑠𝑠𝑑𝑑 /√𝑁𝑁

𝑑𝑑̅ − 𝐸𝐸𝑈𝑈
𝑠𝑠𝑑𝑑 /√𝑁𝑁

where 𝑠𝑠𝑑𝑑 is the sample standard deviation of the paired differences. The test is usually calculated using a
100(1 – 2α)% confidence interval of the mean difference. If the both limits of this confidence interval are between
𝐸𝐸𝐿𝐿 and 𝐸𝐸𝑈𝑈 , equivalence is concluded.

Power Calculation
The power of this test is
Pr�𝑡𝑡𝐿𝐿 ≥ 𝑡𝑡1−𝛼𝛼,𝑁𝑁−1 and 𝑡𝑡𝑈𝑈 ≤ 𝑡𝑡𝛼𝛼,𝑁𝑁−1 �

where 𝑡𝑡𝐿𝐿 and 𝑡𝑡𝑈𝑈 are distributed as the bivariate, noncentral t distribution with noncentrality parameters ∆𝐿𝐿 and ∆𝑈𝑈
given by
∆𝐿𝐿 =

∆𝑈𝑈 =

𝛿𝛿 − 𝐸𝐸𝐿𝐿

𝜎𝜎�1/𝑁𝑁
𝛿𝛿 − 𝐸𝐸𝑈𝑈

𝜎𝜎�1/𝑁𝑁
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with this test such as the means, sample sizes, alpha, and
power.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. Under most situations, you will
select either Power for a power analysis or Sample Size for sample size determination.
Select Sample Size when you want to calculate the sample size needed to achieve a given power and alpha level.
Select Power when you want to calculate the power of an experiment that has already been run.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was
used for power. Now, 0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. Values must be between zero and one. Historically, the value of 0.05 has been used for
alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for
alpha that represents the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
N (Sample Size)
This option specifies one or more values of the sample size, the number of individuals in the study (total subjects).
This value must be an integer greater than one.
You may enter a list of values using the syntax 50,100,150,200,250 or 50 to 250 by 50.
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Effect Size – Equivalence Limits
EU (Upper Equivalence Limit)
Enter one or more values for the upper limit of equivalence. If the actual mean of paired differences is between
EL and EU, the new treatment is said to be equivalent to the standard. Enter values in the range EU > 0 and
EL < δ1 < EU.
EL (Lower Equivalence Limit))
Enter one or more values for the lower limit of equivalence. If the actual mean of paired differences is between
EL and EU, the new treatment is said to be equivalent to the standard. Enter values in the range EL < 0 and
EL < δ1 < EU. If you want symmetric limits around zero, enter “-Upper Limit” here. The program will set
EL = -|EU|.

Effect Size – Mean
δ1 (Mean of Paired Differences)
Enter one or more values for the actual value of the mean of paired differences at which power and sample size
will be calculated. This value is often set to zero for paired data, but it can be non-zero as long as EL < δ1 < EU.

Effect Size – Standard Deviation
σ (Std Dev of Paired Differences)
Enter one or more values for the standard deviation σ of the paired differences (there is one per subject). You can
press the σ button to load the Standard Deviation Estimator window.
If you have a prior ANOVA table, σ may be estimated by √2𝑀𝑀𝑀𝑀𝑀𝑀.

These values must be positive.
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Example 1 – Finding Power
A paired design is to be used to compare the impact of two drugs on diastolic blood pressure. The average
diastolic blood pressure after administration of the reference drug is known to be 96 mmHg. Researchers believe
this average may drop to 92 mmHg with the use of a new drug. The within mean square error of similar studies is
324. Its square root is 18. Therefore, an estimate of σ is given by
𝜎𝜎 = √2 × 324 = 25.4558

Following FDA guidelines, the researchers want to show that the diastolic blood pressure with the new drug is
within 20% of the diastolic blood pressure with the reference drug. Thus, the equivalence limits of the mean
difference of the two drugs are -19.2 and 19.2. They decide to calculate the power for a range of sample sizes
between 5 and 50. The significance level is 0.05.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Paired T-Tests for Equivalence procedure window by expanding Means, then Paired Means,
then Equivalence, and then clicking on Paired T-Tests for Equivalence. You may then make the appropriate
entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alpha ....................................................... 0.05
N (Sample Size)...................................... 5 10 15 20 30 40 50
EU (Upper Equivalence Limit) ................ 19.2
EL (Lower Equivalence Limit) ................. -Upper Limit
δ1 (Mean of Paired Differences) ............. -4
σ (Std Dev of Paired Differences)........... 25.4558

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses: H0: δ ≤ EL or δ ≥ EU vs. H1: EL < δ < EU

Power
0.10599
0.39640
0.66629
0.81214
0.93855
0.98051
0.99410

Sample
Size
N
5
10
15
20
30
40
50

Lower
Equiv
Limit
EL
-19.200
-19.200
-19.200
-19.200
-19.200
-19.200
-19.200

Upper
Equiv
Limit
EU
19.200
19.200
19.200
19.200
19.200
19.200
19.200

Mean
of Paired
Differences
δ1
-4.000
-4.000
-4.000
-4.000
-4.000
-4.000
-4.000

Standard
Deviation
σ
25.4558
25.4558
25.4558
25.4558
25.4558
25.4558
25.4558

Alpha
0.050
0.050
0.050
0.050
0.050
0.050
0.050
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Report Definitions
Power is the probability of rejecting the null hypothesis when it is false. It should be close to one.
N is the sample size, the number of subjects (or pairs) in the study.
EL is the minimum allowable mean that still results in equivalence.
EU is the maximum allowable mean that still result in equivalence.
δ1 is the value of the mean of paired differences at which power and sample size are calculated.
σ is the standard deviation of paired differences for the population.
Alpha is the probability of rejecting the null hypothesis when it is true. It should be small.
Summary Statements ─────────────────────────────────────────────────────────
In an equivalence test of the mean difference from data in a paired design using two one-sided
t-tests, a sample size of 5 achieves 11% power at a 5.0% significance level when the actual
mean of paired differences is -4.000, the estimated standard deviation of paired differences is
25.456, and the equivalence limits are -19.200 and 19.200.

This report shows the power for the indicated scenarios. Note that if they want 90% power, they will require a
sample of around 30 subjects.

Plots Section

This plot shows the power versus the sample size.
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Example 2 – Validation using Chow, Shao, Wang, and Lokhnygina
(2018)
Chow, Shao, Wang, and Lokhnygina (2018) presents an example on pages 46 and 47 of a paired equivalence ttest sample size calculation in which EU = 0.05, EL = -0.05, δ1 = 0.0, σ = 0.1, alpha = 0.05, and power = 0.80.
They obtain a sample size of 36.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Paired T-Tests for Equivalence procedure window by expanding Means, then Paired Means,
then Equivalence, and then clicking on Paired T-Tests for Equivalence. You may then make the appropriate
entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power ...................................................... 0.8
Alpha ....................................................... 0.05
EU (Upper Equivalence Limit) ................ 0.05
EL (Lower Equivalence Limit) ................. -Upper Limit
δ1 (Mean of Paired Differences) ............. 0
σ (Std Dev of Paired Differences)........... 0.1

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses: H0: δ ≤ EL or δ ≥ EU vs. H1: EL < δ < EU

Power
0.80515

Sample
Size
N
36

Lower
Equiv
Limit
EL
-0.050

Upper
Equiv
Limit
EU
0.050

Mean
of Paired
Differences
δ1
0.000

Standard
Deviation
σ
0.100

Alpha
0.050

The sample size of 36 matches Chow, Shao, Wang, and Lokhnygina (2018) exactly.
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Example 3 – Validation using Phillips (1990)
Phillips (1990) page 142 presents a table of sample sizes for various parameter values. In this table, the treatment
mean, standard deviation, and equivalence limits are all specified as percentages of the reference mean. We will
reproduce the second line of the table in which the square root of the within mean square error is 20%; the
equivalence limits are 20%; the treatment mean is 100%, 95%, 90%, and 85% (δ is 0, -5, -10, -15); the power is
70%; and the significance level is 0.05. An MSE of 20% equates to a σ of 28.284%.
Phillips reports total sample size as 16, 20, 40, and 152 corresponding to the four treatment mean percentages. We
will now setup this example in PASS.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Paired T-Tests for Equivalence procedure window by expanding Means, then Paired Means,
then Equivalence, and then clicking on Paired T-Tests for Equivalence. You may then make the appropriate
entries as listed below, or open Example 3 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power ...................................................... 0.70
Alpha ....................................................... 0.05
EU (Upper Equivalence Limit) ................ 20
EL (Lower Equivalence Limit) ................. -Upper Limit
δ1 (Mean of Paired Differences) ............. 0 -5 -10 -15
σ (Std Dev of Paired Differences)........... 28.28427

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses: H0: δ ≤ EL or δ ≥ EU vs. H1: EL < δ < EU

Power
0.70015
0.70958
0.72396
0.70750

Sample
Size
N
152
40
20
16

Lower
Equiv
Limit
EL
-20.000
-20.000
-20.000
-20.000

Upper
Equiv
Limit
EU
20.000
20.000
20.000
20.000

Mean
of Paired
Differences
δ1
-15.000
-10.000
-5.000
0.000

Standard
Deviation
σ
28.284
28.284
28.284
28.284

Alpha
0.050
0.050
0.050
0.050

Note that PASS obtains the same samples sizes as Phillips (1990).
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